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ACCESS TO ADMINISTRATIVE PROGRAMS

Access to the main Administrative Menu can be found at:

http://www.UtahCountyOnline.org/apps/WebAdminMenu.asp

This will provide access to the “generic” applications for all departments.  If you have a
department-specific application, that web address will be given to you separately.

WEB SITE VS. INTRANET CONTENT 

The intended audience for the new web site is non-County employees.  If you have information that
is pertinent only to employees, save that information for the County Intranet, now under
development.  Examples of Intranet content might be: Personnel rules and regulations, Department
Head meeting minutes, employee training classes, etc.

CREATING SHORTCUTS

Browse to the administrative address shown above, then:

In Internet Explorer: From the Menu, select Favorites>Add to Favorites.  In the Add
Favorite dialogue box, you can accept the existing name and location or you can change
the name and categorize your favorites by creating favorites folders and placing it in one of
the folders. Then click OK.  After creating the Favorite, you can create a desktop shortcut. 
From the Menu, select Favorites.  Then right-click on the Favorite you just created.  From
the menu presented, select Send To>Desktop.

In Netscape Navigator. From the Menu, select Communicator>Bookmarks>Add
Bookmark (or press the Bookmark button, if it is visible).  You can categorize your
Bookmarks, as in IE, by selecting, from the Menu, Communitor>Bookmarks>Edit Bookmark.
After creating the Bookmark, you can create a desktop shortcut. Click Bookmarks and
choose Edit  Bookmarks. Drag the bookmark you want to the desktop.

GENERAL INFORMATION

Login Pages. Once you have been given a username and password you can log in to one
of the applications.  Your access may vary by application, so you will need to log in for
each application.  Your access to various features within a given application may also vary
by your access. 

Login names and passwords are case sensitive.  Enter your Username and Password in 
ALL CAPS. Then select your organization name from the dropdown list and press the Login
button.

The login page captures valuable information which is used to identify you and your
organization throughout the application for the duration of your web session.  This
information is needed to make the application function correctly.  When you close the
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browser or are not active on the site for a period of time, the session is terminated and the
identifying information is lost.  You will have to log back in to resume.

If you are unable to log in to an application, and you are an authorized user for that
application, it may be that you have disabled cookies on your browser.  To correct this, do
the following:

Internet Explorer. On the Tools menu, click Internet Options.  Click the Security tab. 
Click the Internet Zone, then click Custom Level.  Scroll down the list of options to
reach Cookies and click the Enable radio button.

Netscape. From the Edit menu, choose Preferences. Click the Advanced category.
Check Accept All Cookies. If you want to be notified when Netscape accepts a
cookie, check Warn me before accepting a cookie.

Categories.  Almost all of the applications utilize user-defined categories. In fact, visitors
to the web site will not be able to find your information unless you associate it with one of
the categories you create. For most applications, you will be presented with an application-
specific menu after logging in. Select the option to View/Add a Category.  In the form which
follows, create a category abbreviation and description.  (The abbreviation is used only
internally.  It is the description that appears to the public throughout the site).



4

Abbreviations must be in all caps with no spaces.  Descriptions should be entered in mixed
case and must be as specific to the department as possible.  (For example:  If your
department is Computer and the category is Training Classes, you should enter Computer
Training Classes, not Training Classes.) 

Your newly created category will now appear in lists and dropdown lists throughout the
County site and in the administrative application you are currently in.

Most categories are not editable from the web.  Because the category Abbreviation may be
inserted into database records and used as a link to tie information together in the
database, the category Abbreviation cannot be changed.  However, the category
Description can be edited.  If you feel strongly that a Description change is needed, contact
a web developer.

In some applications, you will select a single category with which to associate your record.
The category dropdown list will appear in the Add or Update page for the record. (Note that
the category Descriptions you created for your organization are displayed in the category
dropdown list.)
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In other applications, the ability to associate your current record with more than one
organizational category can be accessed via a Details button on the “View” page of each
application.
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Click the Details button. On the Details page, click the Add button to associate a category
with the record displayed on the Details page.

On the ensuing page, select a category from the dropdown list, and click the button.  You
can associate the record with as many categories as are appropriate, provided you first
create the categories.
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Data Entry Guidelines. 

a. An asterisk (*) on a data entry form indicates a required field.
b. Dates and phone numbers should be entered according to the format specified on

the form. Be sure to enter area codes for phone and fax numbers.  (Remember, the
site will be viewed by visitors from other states and countries).

Navigation. Always use the navigation buttons or links that are provided on the web pages
rather than the browser’s Back or Forward buttons.  The navigation buttons/links pass
valuable information from one page to another that is needed for the application to work
correctly.

Files Uploads.  In some cases, an application may enable you to upload a file to the web
server and store information about it in the application’s database.  This allows you to give
web site visitors access to files you would like to share. The following should be kept in
mind when uploading files:

Add Pages. If you try to upload a file having a name identical to one already on the
server, you will get an error message.  If you wish to upload a file of the same
name, rename the new file and then upload it.

Update Pages. If you upload a file having a name identical to one already on the
server, the file you upload will replace the existing file.  If you leave the upload file
field blank, the existing file will remain unchanged.

Delete Pages. The existing file will be deleted from the web server and the
database.
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NOTE: In most cases, web visitors will be able to see images (.jpg, .jpeg, .gif, .png) and
static web pages (.htm, .html) you upload without additional programs or browser plug-ins
installed on their computers.  If you upload a file of any other type, the web visitor will need
to have the corresponding program installed in order to view it.  Often, if it is installed, the
program will launch after the user downloads the document.  If not, the user is prompted for
a folder location to which to download the file.

Converting Files to PDF’s.  In almost all instances, we recommend converting the
document to an Adobe Acrobat File (.pdf).  This is particularly beneficial for web
information that changes frequently. Conversion has the added advantage of appearing
identical to the original document.  Most browsers now include the Adobe Acrobat Reader
plug-in.  If not, the Reader is a free download from Adobe at http://www.adobe.com .  Pages
in the web site which link the visitor to .pdf’s also include a link to the Adobe site.  To
convert your document to .pdf, do the following:

WordPerfect.  Open the document in WordPerfect.  From the File menu, select
Publish to PDF.  In the Publish to PDF dialogue box, select a location within your
folders to store the .pdf file. You can also rename the file, if desired (we’ve had
better luck when renaming). Click OK. The .pdf file is created (unseen) and you are
immediately returned to the original WP document.  It is wise to navigate to the
location where you stored the new .pdf to check that is was created correctly.  If the
file size is 0 or 1 KB, it did not successfully create the .pdf.  Try again, saving the
file with a new name.

Microsoft Word 97 or Word 2000. Open the document in Word. From the View
menu, select Tools>PDF Maker. This will display the Adobe button on the toolbar. 
Click the button and in the ensuing dialogue box, click Create.  MSWord will then
create the .pdf file (it takes a few seconds) in the folder in which the original
document is located.  It will then launch Adobe Acrobat Reader so you can view the
results.

Microsoft Excel. Open the document in Excel. From the View menu, select
Tools>PDF.  This will display the Adobe button.  Click the button and in the Save
PDF File As dialogue box, select a name and location for the .pdf file.  Check the
View PDF File checkbox and click Save.  The .pdf file will be created, after which
Adobe Acrobat Reader will launch so you can view the results.

Adobe Acrobat Writer. If you have trouble converting your files using the built-in
tools, we recommend purchasing and installing Adobe Acrobat Writer (not the same
tool as the Adobe Acrobat Reader). Contact the Information Systems department
for acquisition and installation. Once installed, open the document in its original
program. From the File Menu, select Print.  In the Print dialogue box, select Acrobat
PDFWriter from the list of printers and click OK.  In the Save PDF File As dialogue
box, select a name and location for the .pdf file. Check the View PDF File checkbox
and click Save.  The .pdf file will be created, after which Adobe Acrobat Reader will
launch so you can view the results.

NOTE: PDF files are like a photo or snapshot of the original.  They do not have the
functionality of the original document.  For example, if you convert a spreadsheet to .pdf, it
will look  like the original, but will not be editable.  If you want to share a functioning
spreadsheet, upload the original document.
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CHANGE PASSWORD

• To change your password, enter your current username and password into the form on the
login page, then press Login.  

• The View User page displays your full name, username, password, and organization
abbreviation. (If you are an authorized user for more than one organization, your name will
appear more than once). Click the Edit Button.

• The update form shows your username and password and your access levels for the
organization you chose to edit.  Enter your new password and click the Update button.

• You are returned to the View User screen.  Note that if you are authorized for more than
one organization, your password has been updated for each of those organizations.

• To exit the Change Password program, click the Logout link.
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CONTACT US

This application allows you to enter contact information for your department.  Depending on your
access level you will be able to enter either/both the contact types and/or contact information.  The
data you enter into this application displays on the Contact Us and About Us pages of each
organization’s home page.

View Contact Types. This page displays all of the contact categories that have been
created for your organization.  To add a contact type, click the Add link.

Add Contact Type.  Add a category of contacts for your organization, following the
guidelines established in the General Information section of this document.

View Contact Information. This page displays all contacts for your organization.  To Add,
Edit, Delete, or view Details, press the corresponding link for that contact.

Add a Contact.  Enter minimally the name of the contact and the phone number and/or
email address if this person is to be displayed on the Contact Us page of the web.  (By
definition, a “contact” must be able to be contacted!)  The required Staff Position field is a
generic position and determines that contact’s physical position on the Contact Us and
About Us pages.  If your organization prefers not to display employee names, you can

alternatively type a position name or function name into the Contact Name field. If you
would like to display a photo of the staff person on the About Us page, click the browse
button to locate a .jpg, .jpeg, .gif, or .png image from among your file folders to upload to
the web server when you add the contact record.  To display the contact on the About Us
page, select “Yes” from the dropdown list.  To display the contact on the Contact Us page,
select “Yes” from that dropdown menu.  Use the Biographical Info field to display this
information on the About Us page.
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Contact Information Details. This page displays all the current information for the
contact and provides access to add other details about the contact.  The most important of
these details is the Contact Type (Category).  YOU MUST ASSOCIATE THE CONTACT
WITH AT LEAST ONE CATEGORY. Click the Add button to associate the current contact
with one or more categories.  Once a category has been assigned to the contact, the Edit
button for the contact category appears.  Use the Edit button to change the associated
category or delete the association altogether. 

Edit a Contact.  Use this page to make changes to a contact that has already been
entered.  If you leave the Photo Filename field blank, the existing photo for the contact will
remain on the server.  If you browse for a new photo, the old one will be replaced.

Delete a Contact.  Use this page to delete a contact.  Deleting a contact will also delete
any associated categories.  The photo will also be removed from the web server.
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DEPARTMENT MISSION STATEMENT AND ADDRESSES (LOCATIONS)

This application allows you to enter the mission statement for your organization and the location(s)
of your organization.  Mission statement information you enter displays at the top of the About Us
page for the organization.  Location information appears at the bottom of the organization’s home
page and is displayed by clicking a Locations bookmark at the top of the home page. (The link
appears only after a location has been entered.)

View Department Mission.  After logging in, this page confirms your organization’s name
and abbreviation.  To view your organization’s details, click the Details button.

View Department Details. This page displays your organization’s location(s) and
individual mission statement paragraphs.  To add a location or mission statement
paragraph, click the appropriate Add button.  Once a location or mission statement
paragraph has been entered, the Edit button for the information appears.  Use the Edit
button to Update a location (or mission statement paragraph) or delete it altogether.
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Add a Department Location.  Use the Location Description field to identify the services or
functions available (if applicable) at that location: i.e., “Environmental Services,”
“Administrative Offices,” etc. Use the Building Name to identify the building: i.e., Utah
County Administration Building, Utah County Public Works Building, etc. 

Add a Mission Statement Paragraph. Enter the text for one paragraph of your mission
statement and assign it a number for order of appearance.  You can add as many mission
statement paragraphs as needed.



14

EVENT CALENDAR

The Event Calendar allows you to display event information either on your organization’s Calendar
page, the What’s New column of your organization’s home page, and/or the main page of the
County website.

NOTE: Please enter events only of interest to the general public.  Save employee-specific events
for the Intranet.

After logging in and before entering event information, check the following:

View Cities. Review the list of existing cities. If the city of the event you are entering is not
in the list, add it using the link at the bottom of the page.  Because a city’s abbreviation may
be tied to existing records, editing or deleting an existing city is not allowed.

View Event Facilities.  Review the list of existing facilities. If the facility of the event you
are entering is not in the list, add it using the link at the bottom of the page. When adding
or editing facilities, do not enter specific rooms or areas within the facility.  This is done
elsewhere within the Event Calendar application on a event-by-event basis. Because a
facility may be tied to existing records, deleting of an existing facility is not allowed. 

View All Categories. Two lists are displayed: 1) Your organization’s categories, and 2) All
categories.  Please review these lists. In order to eliminate the duplication of categories in
dropdown lists displayed to the public, please select a category for your organization from
the list of existing categories. If your event does not fit an existing category, then you may
create a new one by clicking the "Add New Category" link at the bottom of the page. Follow
naming guidelines established in the General Information section of this document.
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After checking cities, facilities, and categories, you are ready to enter an event.

View Calendared Events. This page displays all events for every organization.  Use the
sorting options and the navigation arrows to locate a specific event.  To view event details,
click the Details button.  If your organization created the event, the Edit and Copy buttons
also display. To Add, Edit (including Delete), Copy, or view Details, press the appropriate
link for the event.

Add an Event. Enter the information for the event, using the date and phone formats
shown. Sponsoring/Producing Organization information can be very helpful in determining
whether or not to attend an event.  For example, a production of the musical, Les
Miserables, produced by the local high school will be far different from one produced by a
Broadway touring company.  Enter this information whenever possible. For the Public
Information Phone field, enter a phone number where the inquirer can get detailed
information about the event.  Do not enter the phone number of the Event Facility, unless
that facility also answers questions specific to your event and has agreed to do so.

If your event is of interest to a significant number of visitors to the entire County web site,
then select “Yes” in the “Display County-Wide” field.  To display the event in the What’s
New column of your home page,  select “Yes” in the “Display in Departmental ‘Whats New’
Column.” Your event will display there if it is in the top five events (in order of date) for your
organization. 
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Event Details. This page displays all the details for the event. If this event record was
created by your organization, Add and Edit buttons display, providing data entry and
editing for the details displayed. Click an Add button to add an associated detail. Once a
detail has been added, the Edit button for the detail appears.  Use the Edit button to
change the associated detail or delete the detail altogether.

Event Categories. The most important of the event’s details is the Event Category. 
YOU MUST ASSOCIATE THE EVENT WITH AT LEAST ONE CATEGORY. 

Date/Time/Rate Details. Use this form to enter rates and/or times which may vary by
day of week, date, or time.  You can enter as many Date/Time/Rate Detail records
as you have variances in those details.

Event Contacts.  Use this form to enter information about event contacts. Event
contact information does not display anywhere on the web site. This feature is
provided as a courtesy to enable you to get further information for this event now or
in the future.

Update or Delete an Event.  Use this page to make changes to an event that has
already been entered. Deleting an event will also delete any associated details.

Copy a Calendared Event. Use the Copy feature to copy a past event.  Then change the
dates to create a new event.  The copy feature does not copy any associated categories or
details (on the assumption the category and/or details change from year to year). 
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FREQUENTLY ASKED QUESTIONS (FAQ)

This feature enables you to post questions(and their answers) that are asked on a frequent basis. 
The information entered into this appliction is displayed on your organization’s FAQs page and can
be accessed by clicking FAQs in the navigation bar.

View FAQ Categories. This page displays all of the FAQ categories that have been
created for your organization.  To add a contact type, click the Add link. To update the
category, click the Edit button. (This is one instance wherein a category can be edited).

Add a FAQ Category.  Enter a mixed case description for your FAQ category and select
the  order you want this category to appear on the FAQ page for your organization. 
Currently, the FAQ page for you organization is programmed to display a maximum of four
(4) categories.

Update a FAQ Category.  You may edit the description for the category or its order.   You
may not edit the category number, nor delete the category, as it may be tied to records.

View Frequently Asked Questions. This page displays all the questions for your
organization.  To Add, Edit (including Delete), or view Details, press the corresponding link
for that question.

Add a Frequently Asked Question.  Enter the question (don’t forget the question mark!)
and select a category from the dropdown list of categories you created.  Enter a number for
the order in which you would like your question to appear within the category.

Question Details. This page displays all the details (answers) for the question. Click an
Add button to add an associated answer. Once an answer has been added, the Edit and
Delete buttons for the answer appears. 
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Add an Answer Paragraph.  Use this form to enter an answer paragraph and its
order within the question.  You can also provide an additional information link for
your web visitor by typing the link into the Link URL field.  OR, you may upload a file
and link to it by clicking the browse button for the Upload Link field and locating the
file on your file system.  Only one link per paragraph, please! Please do not enter
both a link and an upload file or your FAQ page will become confused! If you enter
either a link or an upload file, you must enter a Link Description.  It is the Link
Description that displays as a link on your organization’s FAQ page.

Edit an Answer Paragraph.  Use this form to edit an existing answer paragraph. 
Remember, only one link per paragraph, please!  If you choose to upload a new
file, it will replace the existing file on the web server.

Delete an Answer Paragraph.  Use this form to delete an existing answer
paragraph.  An uploaded file, if there is one, will also be deleted from the web
server.

Update or Delete a FAQ.  Use this form to update a question or delete it altogether.
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WEB LINKS

The Web Links application is a multipurpose upload/link program that allows you to display links
dynamically.  These links can be designated to display on the Related Links page for your
organization, the links page for the entire County, or can be displayed on a custom-built page for
your organization. 

View Web Link Categories. This page displays all of the link categories that have been
created for your organization.  To add a link category, click the Add link.

Add Contact Type.  Use this form to add a category of links for your organization,
following the guidelines established in the General Information section of this document.

View Web Links. Because two types of links can be created, this page displays two lists of
links that have been created for your organization: one for uploaded files and one for
traditional links. To Add, Edit, Delete or view Details, press the corresponding link or
button.
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“Add Link” Menu.  When you press the Add button from the View Web Links Page, you
are given the option to upload a file and link to it, or to link to another web site.

Add an Upload Link. Use the browse button to locate a file for upload from among the files
on your file system.  Also, enter the required Link Name.  It is the link name that displays
the link on the Related Links page.  To display the link on the County links page, select
“Yes” from the “Display County Wide” dropdown list.  Please do this only if your link is of
interest to a large segment of visitors to the main county site. If you want the link to display
on the Related Links page for your organization, select “Yes” from the “Display on Related
Links Page” dropdown list. If this link is to be displayed on a custom page built by a web
developer and you do not also want it displayed on the Related Links page, then select
“No” from the “Display on Related Links Page” dropdown list.

Add a Web Link. Type in the full web address of the web page you wish to link to.  This
can be another site or a page on the County site.  Be sure to precede your link with http:// .
Also, enter the required Link Name.  It is the link name that displays the link on the Related
Links page.  To display the link on the County links page, select “Yes” from the “Display
County Wide” dropdown list.  Please do this only if your link is of interest to a large
segment of visitors to the main county site. If you want the link to display on the Related
Links page for your organization, select “Yes” from the “Display on Related Links Page”
dropdown list. If this link is to be displayed on a custom page built by a web developer and
you do not also want it displayed on the Related Links page, then select “No” from the
“Display on Related Links Page” dropdown list.

Web Link Details. This page displays all the current information for the link and displays
one or more link categories that have been associated with the link.  YOU MUST
ASSOCIATE THE LINK WITH AT LEAST ONE CATEGORY. Click the Add button to
associate the current link with one or more categories.  Once a category has been
assigned to the link, the Edit button for the contact category appears.  Use the Edit button
to change the associated category or delete the association altogether.  If you are having a
custom page built, it will be based upon a category of links.

Edit an Upload Link. Use this form to edit an uploaded link.  If you choose to upload a new
file, it will replace the existing file on the web server.

Delete an Uploaded Link. Use this form to delete an existing uploaded link.  Any
associated categories will also be deleted. The uploaded file will be deleted from the web
server.

Edit a Web Link. Use this form to edit an existing web link.

Delete a Web Link.  Use this form to delete a web link altogether. Any associated
categories will also be deleted.
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MINUTES

The minutes application allows you to upload minutes from department meetings, board meetings,
etc.  Like most of the other applications, minutes must be assigned to categories.  A custom page
will be built (based upon the minute category) for you organization if you choose to upload
minutes.

View Minute Categories.  This page displays all of the minute categories that have been
created for your organization.  To add a  category, click the Add link.

Add a Category of Minutes. Use this form to add a category of minutes for your
organization, following the guidelines established in the General Information section of this
document.

View Minute Uploads.  This page displays all the minutes that have been uploaded for
your organization.  Use the sorting options and the navigation arrows to locate specific
minutes.   To Add, Edit or Delete minutes, press the appropriate link or button for the
individual minutes.

Edit Minute Upload. Use this form to edit uploaded minutes.  If you choose to upload a
new file, it will replace the existing file on the web server.
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Delete Minute Upload. Use this form to delete minutes altogether. Any associated
categories will also be deleted.
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SURVEY

With this application, you can create a survey for the general public.  Information entered into this
application appears on the Survey page for each organization and optionally on the County home
page. You can enter any number of questions with multiple-choice answers and view respondent
data.

View Surveys. This page displays all the surveys that have been created for your
organization.  Use the sorting options to locate specific surveys.   To Add or  Edit a survey, 
click the corresponding link.  To view the Details (including the creation of survey questions
and multiple-choice answers), click the Details link.  The view current survey results, click
the Results link. 

Add a Survey.  Give the survey a name and a brief description.  The survey name and
description will be presented as a list of possible surveys for the web visitor to take. To
display a link to the survey from the County’s home page, select “Yes” from the “Display
County-Wide” dropdown list. This form automatically inserts an expiration date that is prior
to the current date. This is done to prevent the display of the survey until all the questions
and multiple-choice answers have been created. To display a survey to the public, change
the survey expiration date to a future date. This is done on the Edit Survey page.

Survey Details. This page displays the survey information and provides links to forms
which create or edit survey questions and multiple-choice answers. To Add a survey
question, click the Add link. To Edit a question, click the Edit Question link on the
corresponding question row. To add a multiple-choice answer, click the Add Answer link on
the corresponding question row.  To Edit an answer, click the answer text.
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Add a Survey Question.  Use this form to enter a single survey question.

Edit a Survey Question.  Use this form to edit an existing survey question. NOTE: A
delete button is provided for your convenience to delete a question before a survey
starts. DO NOT delete a question once the survey is underway, as there may be
survey responses tied to the record number of the question.  DO NOT edit a
question once the survey is underway, as subsequent respondents will be
answering a different question.  This may skew the results of the survey.

Add a Survey Answer.  Use this form to enter one of a set of multiple-choice
responses.  Make the answer as succinct (brief) as possible, since these multiple-
choice answers display in a dropdown list when the survey is taken.

Edit a Survey Answer.  Use this form to edit an existing survey answer. NOTE: A
delete button is provided for your convenience to delete an answer before a survey
starts. DO NOT delete an answer once the survey is underway, as there may be
survey responses tied to the record number of the question.  DO NOT edit an
answer once the survey is underway, as subsequent respondents will be answering
th question with a different set of answers.  This may skew the results of the survey.

Edit Survey.  Use this form to edit the survey name and/or description and to enter a new
expiration date for the survey. To display a survey to the public, change the expiration date
to a date in the future. It will not display beyond that date. To discontinue a survey prior to
its expiration date, move the expiration date backward.
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Survey Results. This page displays the survey questions, answers, and the number of
responses to each multiple-choice answer. To view even more details, click the Survey
Name.

All Survey Results.  This page displays all the responses to the survey.  Use the
navigation links provided to display more survey results.  To view Respondent information,
click the Respondent ID number.
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Respondent Details.  This page displays personal information about the respondent, if
he chose to provide that information when he took the survey.
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WHAT’S NEW (NEWS) 

This application allows you to share news and updates about your organization. Information
entered into this application is displayed in the What’s New column of your organization’s home
page, on the News page for your organization, and optionally on the County home page. 

View Whats New Categories. This page displays all of the What’s New categories that
have been created for your organization.  To add a  category, click the Add link.

Add a Whats New Category. Use this form to add a News category for your organization,
following the guidelines established in the General Information section of this document.

View News Items. This page displays all the news items that have been entered for your
organization.  Use the sorting options to locate specific items.   To Add, Edit or view Details
for a News Item, press the corresponding link or button.

Add a News Item. Enter a Headline and Short Body Text.  The headline and short body
text both display on home page - the headline as a link and the short body text as “teaser”
text designed to entice the reader to click on the link. Enter an expiration date (beyond
which the item will not display on the web), using the format shown.  Select a category from
the Category dropdown list, the contents of which you created previously.  Your news items
will be sorted on the web page by category.
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News Item Details. This page displays all the current information for the news item and
provides access to add other details about the item.  From this page, you can enter one or
more detailed “long body” paragraphs, upload and link to related files, and provide the user
with a link to another web page for more information. Click the Add button to associate the
current news item with one or more of the details.  Once a detail has been associated with
the news item, the Edit and Delete (where applicable) buttons for the detail appear. 

Add a What’s New Paragraph.  Use this form to enter a “long body” paragraph and
assign it an order of appearance number. You can add as many paragraphs as
needed to tell your story.

Update or Delete a What’s New Paragraph.  Use this form to update an existing
paragraph or delete it altogether.

Add a What’s New Upload.  Use this form to upload additional information to the
web server that you want to share with your readers. Describe the upload briefly,
then browse through your file system to locate the appropriate file.  If your file is a
web image (.gif, .jpg, .jpeg, .png), you can optionally select it to display at the top of
the story detail page when the web visitor clicks the What’s New link.  The image will
be resized to fit the page.  A link to all uploaded files will appear below the body of
the Whats New story on the story detail page.
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Edit What’s New Upload. Use this form to make changes to your upload information. 
If you choose to upload a different file, it will replace the existing file on the web
server.

Delete a What’s New Upload.  Use this form to delete the uploaded file entirely.  It
will be removed from the web server.

Add a What’s New Related Link.  Use this form to link to another web page.  Be
sure to precede the web page with: http:// . You can link to another site or to a page
in the County site. Enter the URL, a Link Name, and an optional Description.

Edit a What’s New Related Link.  Use this form to edit the link or delete it entirely.

NOTE: Do not use the What’s New application for events.  Use the Event Calendar application
instead.
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If you have additional questions please email or call:

Loretta King
Email: ucadm.lorettak@state.ut.us
Phone: 370-8415

Leena Kumar
Email: ucadm.leena@state.ut.us
Phone: 370-8419


